1.)Draw this in your drawing copy
2.)Children can use any colours that are available at the home
3.)Stay Home Stay Safe

Assignment 4




Jagat Taran Golden Jubilee School

Session 2020 -2021
Class IV

Subject : Computer Science Assignment : 4

Lesson 4 - Complete the exercises (Fill in the blanks, State true or false, Multiple
Choice questions in book.
Lesson 4 - Do the Answer the following questions in fair copy.
{Two liner interleave notebook}.

Online link:-

https://drive.google.com/file/d/140ZDe2ucpcSSsXcKzrir3icGuZz2A4dtw/view?u

sp=sharing

Note book work:

Write the shortcut keys and their purpose in your notebook neatly.

Shortcut Purpose
Ctrl + Home Jump to the top of the document
Ctrl + End Jump to the bottom of the document
Home Jump to the start of the line
End Jump to the end of the line
Ctrl +c Copy selected text/object
Ctrl +v Paste the copied text/object
Ctrl + x Cut selected text/object
Ctrl +w Close the document
Ctrl + z Undo the last operation

Ctrl+y Redo the last operation



https://drive.google.com/file/d/14OZDe2ucpcSSsXcKzrJr3icGuZz2A4tw/view?usp=sharing
https://drive.google.com/file/d/14OZDe2ucpcSSsXcKzrJr3icGuZz2A4tw/view?usp=sharing

Ctrl +s Save the document

F12 Save as
Ctrl + n Create a new document
Ctrl+o Open a document
Ctrl+p Print the document
Ctrl +f Find
Ctrl+b Make selected text bold
Ctrl +u Underline selected text
Ctrl +i Make selected text italic
Shift + enter Insert a line breaks
Ctrl + enter Insert a page break
F1 Display help

Answer the following questions

1. How will you apply text formatting to another selection?
Ans: To apply text formatting to another selection:- first you select the text or graphics
whose formatting you want to copy. Then on the Home tab, click Format Painter. The
pointer changes to a paintbrush icon. Now apply the copied format by dragging the
brush over the desired text.

. Why do we use Header and Footer options?
Ans: Headers and footers are typically used to place some information on top and at
the bottom of every page respectively. In addition to page numbers, a header or footer
can contain information such as: The document name, the date and/or time you
created or revised the document, an author name, a graphic, a draft or revision

number etc.

. What is indentation? List the types of Indentations.
Ans: Indentation determines the amount of spacing between the text and the page
margins.
Word provides four types of indents: first line indent, hanging indent, right indent and

left indent.




4. What are page margins? What are the default settings of left and Right Margins?
Ans: A margin is the space between the document text and the edge of the page. The
default settings of left and Right Margins is 1" from the right and left edges of the
page.

5. What do you understand by the print preview option?

Ans: Print preview option is provided for displaying a page, document or any other
material before it is sent to a printer. Print preview is a useful function to users as it

helps them to see how the final printed material will appear.




MORE ON MICROSOFT WORD 2016

't ‘\\:N:.\:\' INCTHIN O M AT N
tawy W J"‘\‘“H": TR R o Faun Kt

g O N At

Py W i el e Tt e l'h‘}"'ﬂhi-t
s B T A

. Rkt e tend e e P e

“r\\:\i ‘\‘\“1 In \\\\l\! Pt s that !h"lp‘q Vo Lo et ihiw TR (o l“ll‘l”l"h wial outlaak. 1
only }‘1\‘\'idt‘\ the facility to type and madity the tesg, It alsan b featieers o enhane o e ovegall
\‘P}“‘\“Jl}\‘(‘ (\' tht\ t“‘t\ \\‘lt \ \"\ '["\i b"‘\l l I"PI.‘\ [ ] 1'"\ t.\\i. s‘t!l !I“* 'ht}"ﬂ +‘||'I“.‘I ‘“h il ll" ||||| \r.]“l “l-'“ll
wd alho eview adocument betore prnting it

o COPY FORMATTING TO ANOTHER SELECTION
The Format Patnter tool s used to copy and apply text formatting and s Db pgraphie s fovmating
wchasborde

¢t the text or uraphics whose formatting y

s and fills to another selection,
» Sele On Want to copys Click on the Formast Palintes
button & inthe Clipboardgroupon the Home tab,

es into a ush \h.l|ln. Now, ‘||1|\l\4 the “1|1[m[ format hy iaptpthg (e ey

» The pointer chang
over the desired text,
dtothe selected texd

» Theformatting attributes ol the previous textwill heapplie

® FINDING THE TEXT
veurrent document, follow the glvenstops

Tofind aparticular word or phraseinthe
» Click on the Find button it In the Editing group on the Home _

tab.
left of the document window,

> ANavigatlonpmwnpm?nr'ntntlw

;11ynuw.mtInHmllnllw“n*.mI| -

> Youcansimply type theword th
caults will he displayed i the

document’ box. The wearched o

Navigation pane with the higghlightedwaor du, O
y from the drop-downment ol

Select the Advanced Find optiol
Ihe Find and Replace dialog

the ‘Search document’ text hox.
boxappears as shown inFigure 4.1,

> InFind what box, type the text that yourws
document,
fuapining '(“’.' {7

{wpnpilaty with

———————————
R

Scanned with CamScanner

§ ol wod Huplse e

I lgghir e {1
Plaleagy Pree

it Lo searchin E




Vs S e Fved Mas b bbb Ve paaitse e bt e

VA o B b s e b e e Tl g
Hpde ! e il

Ve W s b A iy e e
A T e b

R R LT e T T R TR T TR R Y R R TN LR

& L L SR [ O N TR (N T T [ L A O e L e TR T LI E e [ T
i A A e e b e e

Vo e e v ebe by el b el el e
e i il

At Al bt )y e
VR D e g R LR R A e (WL B (VT YT
ir}t\ht.wnﬂlhlﬂﬂlIHIL|HlHHIIHH|HWH4H11HIH~!Hﬂ?quhHhFl;d” |
R L O e A L T T | [T A T TR T e (TR (TR A
s o s e an ! :

EONREPEACING THE X

Iirahthhrhﬂ||ﬂnpi|h=ivni\unlnd“-ﬂhu[sqﬂ”|ullp;ﬂwu.t.u|plnq-n.,;HIp;H;
A e lnl»qdnuuinvd.Ian\rihu,Uth|u|n#ahnrn

L L AT T e T E T RN T e T e o [N N R N S
Phwe Er b ansd fsspban s Dot e g I Emebwiliad Do, g Hp i
Ca ks e bt b b D Bspabes s R Dvie st iieg s st ot by

oo v et tesd Tiotih it el
e | Ry | e l-;l.rul;nr;r;l

N N R e T R R

i
e e el '
CRW o Temow | |

FTHTRIT
Pl sl dur |

j

Clek o et Meplass/Muplaes 0

ANk o e b i
W e W has Hndsbisel s i i]t, 4 Hi
For the waord anll el

Pepan et a peaigple e e e

J|4HW'FI'|h|"”1 Fhgirs A Sl hd bl Bugpdaen Fidaliag Hiip

[ nnphur:hulhu;-hwuﬂr~Ihu.qnn|hudph~liuihih»;p.;IL,|1q;L“f“¢Lh

‘& “la'!':‘liIH-*J"'HI"-Ilnlu

e gl s AN Db el s alb Vs v e e s ol B siap bl et i

et s bt

Jaatiitig :
Lty Wil (s o

I

1i1

i
il

r,‘f

i |

I

Phpsnnl Fslidey
1 ity 1)

/

(N

Tl

1inh I il
11 i_:

1

o

I n

Wi it iyl

{2

Scanned with CamScanner

My

g

¢ ol

il #i

{



L youcanreplace the textinWord 2013 in the same way as you do in Word 2016.

$ PAGE FORMATTING
CREATING HEADER AND FOOTER

Header and Footer is used to place some information on top and at the D @ .

bottom of every page, respectively. You can include the title, chapter’s |
Header Footer Page

heading, date, page number, author'sname, etc. inthis section. - *  Number~ P

: oo B

» The Header and Footer buttons are foundin the Header & Footer group cader & Footer . !
) . Figure 4.3: Header & Footer

on the Insert tab. Click on the Header button. Select the Edit Header Tools I

option in the drop-down menu. Likewise, select the Insert > Footer >
Edit Footer option to display the Footer box. An additional tab named Design willappearonthe

Ribbonunderthe Header & Footer Tools section.
» You will find the Header and Footer boxes at the top and bottom of each page, respectively,

separated by the dottedlines.

» Click on the Header box and type the text that you want to display here. For example, ‘KIPS

LEARNING’on the left side.

> Press the Tab key twice. The insertion point will jump to the right side. Click on the Date & Time /
buttonin the Insert group on the Design tab under the Header & Footer Tools section. The Dateand
Time dialog box appears. Choose the desired date and time format. Click OK. |

» Click on the Go to Footer button in the Navigation group. The cursor will appear on the left side of
the Footer section. Press the Tab key and the cursor willjump to the centre of the page.

button in the Header & Footer group and choose the desired format
ge number style then select the Format

» Click on the Page Number
from the drop-down list. If you intend to apply specific pa

Page Numbers option from the drop-downmenu.
box appears. Define the settingsasperyo

n the Design tab to come out of the Hea

ur need and click OK.

> ThePageNumber Format dialog
der & Footer

» Click on the Close Header and Footer button o

Tools section.

o apply

follow the above given steps t

and Footer group and

Click on the INSERT tab, select the Header
| \,Heﬂdcr and Footerina documaent. _— -
"TER——— ” S — —— ’ - - e i— Lcarning :
computers with KIPS @
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SETTING PARAGRAPH SPACING
Paragraph spacing is the amount of space above or below a paragraph. Follow the steps tq et
i paragraphspacing.

> Selectthe paragraph before orafter which youwant to change the spacing.

> Click on the Paragraph dialog box launcher button & onthe Home tab. The Paragraph dia!og;.’.l
willopen.

> Select the Indents and Spacing tab. Enter the required spacing in the Before and After Spin by,
under the Spacing section. Click OK.

. & Tosetmore precise spacing measurement, click on Line and Paragraph Spacing ‘=~ buttonin the
- "5 Paragraph group under the Home tab and select the Line Spacing Options from the drop-down men,

The Paragraph dialog box will appear. Select any specified value for the line spacing and paragrzy-
spacing.
CHANGING LINE SPACING =z 55 H
Line spacingis the vertical distance between successive lines of the textina == e o
Perzgrapn e
document. We can also increase or decrease the line spacing hetween a ssemen . K
paragraph. St
> Selectthetext. Click onthe Paragraph dialogboxlauncher & , G i
> The Paragraph dialog box appears. Select the Indents and Spacing tab h?w T E =
and then select the required Line spacing option under the Spacing - _
section. Click OK. = 2w E
In 2 similar manner, you can set the Paragraph and Line spacing from the o W
{ HOME tabin Word 2013. — iy —
INSERTING COLUMN AND COLUMN BREAK Y

.......

~ When you type in Word document, by default the text s displayed in 2 sing]
. paragraph style. If you wish to format the documentin newspaper style. i o

., colu ¢ 0
2016enablesyoutocreateadocumentintwoormorecolumns. _
Using Column Button ’
The easiest way to create a multi-column documentis to use the Columns byston = o L yot?

the Page Setup group.

> Selectthetext. Clickonthe Columnsbutton.
‘ Learning gre . AN
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. Adrop-downmenu displays the choices of colum
ns.

C ohurmng

Prevety

elect the number of columns that you would like to insert in
your document. () (m) m fiE
| et

Qne Two [heee

¥y

>

Humbet of columng. |
Width and ypacing

» 1f you want to customise the column then click on the More
Columns option in the drop-down menu. The Columns dialog | gore: wian s
box appears. Define the desired settings and click OK. | : v | Ky
T

fqual tolumn width

Applyta: ' Selected texd v:

i | oK ‘I Cantel

Inserti
rting Column Break Figure 4.5: Columns Dialog Box

| e 1T YOU have already added columns to your word document, then
= W oo SO you might have noticed that some of the columns are not as
g balanced as you would like them to be. One solution to this problem
T e is to add a column break. It will force the end of the column and

= vemewe | MoOve thattext to the beginning of anew column.

secton on Uhe LA Fage

Figure 4.6: Selecting Page
Breaks Option

» Placethe cursorbefore the text where youwantto insert column break.

" on the Layout tab and select the Column option from the

» Click on the Breaks button "= Bresks ~
drop-down menu.

> Youwill observe thatthetext following the column break will beginin the next column.

ﬂw tab and select the desired options. |

| Toadd columns and breaksinadocu
b

WORKING WITH TABS

used to move the cursorat certain
tthe Tabstops alongthe
y jumps to
hes in the

he text is to use the Tab key. Itis

setatevery0.5 inch.Youcanse
key, the cursor automaticall

The most common way to indentt
spacesinadocument. By default, Tabstopsare

ruler according to your requirement. When you press the Tab
the next tab. Tabs can also be created using Leaders lines. The Leaders insert dots or das

space leadingup tothe Tab stop. Tosetthe Tab stop, follow

» Click onthe Paragraphdialog box launcherinthe Layout tab.

g box will appear. Now, click on the Tabs button ==
log box willappearon the screen.
position: Text box.

Learning Ki pS /\4_1\\

the givensteps:

presenton the lower left

> The Paragraphdialo

of the dialog box. The Tabsdia
ple,1.25”in the Tab stop

> Typeatabposition forexam
Computers with

B

Scanned with CamScanner



I

onelectany of the Alignment options and click on the Set button, el —
e = - :-:Efe.‘
Yoosimdlan iy setanew tabat 3" and click OK. e ok
; _ I o s
Y ONow, press the Tab key, The cursor will jump to the next position .
Ian stop pes _ Ces,
Whereyouhavesetthe Tabstop., A—
Yorcan Quickly set 1abs by using the Tab selector  « button present on = —
g'{g\ thedettend of the Ruler barina document, Keep onclicking the button until é;ﬂ O goneer
. i . itCmal oy
lisplays the type of tab that youwant to set. Then, clickonthelocationon | we.
] Mo O2__
the Ruler bacwhere youwant to set the tab., Os__
............................................ 5= o
m Figure 4.7: Tabs [
Box

( WO 2013, voucanset the tab position fromthe PAGE LAYOUT tab. j

INDENTING TEXT

Indentation determines the amount of
spacing between the text and the page
margins, Indenting basically draws the
reader's attention. The  Indentation
feature is used to move a complete

paragraph or

the first line

of

d

paragraph to a specitic position, either

fromthe left orright margin,

> Selectthetext tobeindented.

» Click on

the

button ' in the Paragraph group

s ! w1l o R C? e
on the Home tab. The selected text [Msie 2w (3 e
Figure 4.8: Indenting Text

will shift ¥ inch away from the left

margin,
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comes from learning. It is of no value unless You put it into pracice

D t—p

Increase Indent |. |Decrease Indent |

. S -

o E -

> Clickon the Decrease Indent button B to move the text ¥ inch closer to the left margin.

‘ M Waoidd ad i, you can also indent the text h_\' Leled ting the Increa
I'!.! eaet vy the HOMIE talh,

L

Compaons win KPS ,';'-f'f';"

You can alvo set the indents by the dragging method. Select the par

Indent, Left Indent, Right Indent or Hanging Indent on the Ruler bar.

—
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» SETTING PAGE PROPERTIES

WI”‘I'-"IHII' 'l'||||“llf¢ Ili‘;l" Ill“l””{l!l”fi'jf" Illl!|f (T }'”l‘I”lj{“““”’E“IL"th’i’a,‘ "'i“','”'h”h“"ls“," '-'ﬂ‘,“lf ;

o TTING MARGING

gl refers to the oot of space that 1e el from the edpge of the page and the docament text,
’

Mt

W,,,:],"Illh-l”flw'* yorto et themarping onall the four sldes af adocament, e, tap, bottom, left, and

fpht, The dofault smarghns are st at 1 from top and bottor and 1 framleft and right edgpe of the

page

getting Margins using Ruler Bars

Foge by

to changie the leftorightmarging, polnt toamar o boundary Gnthe e e

[raspe

»

Hm}nlrll-ﬂ puler, Whern the |Hl|ll|l‘l chanpes 1o oa toubile headed - - e : :
- . ] T s - «|
arrow e, drag the marginboundary s per your need, -
RIS
» 1o change the top or bottom mar glns, polnt toamargin houndary on - 5200

the Vertical ruler, When the polnter changes to o double-headed e

arrow 1, drag themarginboundary, asrequlred,

To Specify Exact Margin Measurement

Fpenyin W Al |

» Select the Layout tab, Click on the Margins option in the Page Setup

1 e CE) T e
proup, A drop-down list of options appears, The Normal option s !
: =" Flgure 4.9 Pago Sotup
selected by default, Selectany pre-defined marginsetting, Or Diatog Box

Select the Custom Marging tab, Type the values for Top, Bottom,
Left, Right, and Gutter margins or click the spinbozestoset the margine,

Inthe Apply to drop-down list, choose the option; Whole document, Click OK.

SETTING PAPER ORIENTATION

[he Page Orlentation |5 the property to et the printing direction of the text, The default orientation is
Portrait, in which document {4 printed length-wise, When we choose Landscape orientation, the

document I printed width wise,
fochange the page orlentation, follow the given steps:
> Selectthe Layout tab, Click onthe Orlentation buttonin the Page Setup group.

g rhfm'.r-le.;mdsr.npur:rit'n!.'stlunfrrmlHn-rlmptluwnIi'.l.{)h'.(-w:-Hu'r'IhH‘E-‘.{'-

SETTING PAPER SIZE

ons depe n the
Inord 2016, you can work with different sizes of paper, but the available selections depend 0

Ypeof printer youuse,

Laarning Kips .!}

Compulers with
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» Ok o0 the Paper tab select the desiind e
sze froin e Paper sfze diop doanadisg o

>  Obsenve the change i the Preview Dl b arh bk Gk '

THE PAET VLTI Ot as s alv avadalile vt PAGELAYVOURE Ll W g :
e
}
¥ PREVIEWING A DOCUMENT i
Word 2016 allows vaur 1o preview the dovaiment et printing ol thy .
SIVON STEPs 1O i ew adocumeint ;Ii__ |
»  Chohonthe File tab amdselent
the Print option -
» A preview of your document ~
automatically appean anthe
?'E:.".t vigde of the Wil b
window. To view eadh page, .
clichk on the Navigatien
buttons w v Delow the
DrEVIeW L Tion ;
|
> You can magnity the view uf Fighae 4 10 Prsviewing o Do wiisnd :

MW

the page by using the 2oom

Slider bar at the bottomoght comer o the pieview ses Hon
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SEIRECAP g |

L > The Format Painter tool is used to apply text formatting and some basic graphics formatting, Such
‘ borders and fills to another selection, ‘
]5 > Thetindoption findsaparticular word or phrase Inthe current document.

l » The Replace option inWord offers a facllity to search a particular word or phrase and replace it wit,,
nes word,

Header and Footer are used to place some informatlon on the top and at the bottom of every page

respectively,

v

> Linespacing s the vertical distance between successive lines of the text ina document.
> Paragraphspacing determines the amount of spaces above or below a paragraph.

» Bydefault, Tabstops are set at every 0.5inch,

> Indentation determines the amount of spacing between the text and page margins.

» Margin refers to the amount of space that is left from the edges of a paper where the text actual
hegins to appear,

Y

Page Orientation s the property to set the printing direction of the text on paper.

S — —— ——

SECTION - A

A. Fill in the blanks.

!
1. Thedefault margins are setat ... b from top, bottom, left, and right edgec':
page. 1

3. TheColumn breaks optionis presentonthe ... Laud G'LLQT ...tab. -
4.  Format Painterisa ’roﬂa le ....button.

5. Thedefaulttabstopsaresetatevery .. 0.8 inch. ;I
6, L&M - SFMW JIsthevertical distance between successive lines of the textinadocu™
“1" » Toggle * Double-click 205 s Line Spacing » Layou!

Learning . {,/ N
Computers with |_‘(_I£'S_j_ (’/’
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g State True or False.

i indentation determines the amount of spacing above or below a paragraph. E
) Tab keyisUSEdtO move the cursorat certain spacesinadocument. I]
, ThePage Break option splits the documentin two or more columns. _F_:__
4 Landscape is the default paper orientationin Word 2016. E
g The Increase Indentbutton shifts the text 1" (inch) away from the left margin.
C. Application-based questions.

he topic-'Keep Your City Clean'.

Aaryan has been given an assignment to write three paragraphsont
spacing before and after the

Help him format the document by setting the indents, margins,
paragraph.Namethe optionsthathewoulduse toformatthese.

Word 2016. Her Science teacher has asked her to

2. Diya has created a Science project of five pagesin
on all the pages. Suggest her the most suitable

mention the topic, page numbers, and her name

option for the same.

SECTION-B

A. Multiple-choice questions.
d to search any particular word or phrase ina document.

1. The .optionisuse
J./Find b.Search c.Replace
[ PV ——— option divides adocumentin two or more columns.
a.Tab .b,€blumns c.Header

3. The selected text can be shifted half inch away from the left margin by using the .. e

button.

a.Decreaseindent \)ﬁncreaseindent ¢.Spacing

Learning .
Computers with KIPS L‘r"/
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4. Thetopandbottommarginsofadocumentcan be changed by using the

\Artical ruler b. Horizontal ruler c. Tabstop

5. Tomovea paragraphorlinetoaspecificposition,the E—— | {1]{ Tt TTTT Y|

a.Format Painter b. Paragraph Spacing JIndenting

B. ~Answerthefollowing questions.

1. Howwillyouapply text formatting to anotherselection?

2.  Whydowe use Headerand Footer options?

3.  Whatisindentation? List the types of indentation.

...............................................

4.  Whatare Pagemargins? What are the default settings of Left and Right margins?

.................................

5.  Whatdoyouunderstand by the Print Preview option?

Eampuirs win KPS <18
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Ceptre of the pagie,

“M(In|||¢'|)¢l;-‘,l‘|ll|“|W“'""llllll‘-Il'-fll}{fill‘Cl')lllmnsu['lllr)ll' 5¢t Line Spacing of the page to doubl
_ b 5 agetodouble.

hel two Labs inthe frstcolumnto allgn NAME and D,0,B 45 shown in the glven fig i

Lelect e headings NAME and D048, i MV EDTGHE:

, , . OB, ke them Bold, Underlined, change their Font Size and Font

colowr to 18and Dark Blue, respectively, Enter the data using tabs

M"‘f’”‘""”“H”""”"'I""“*llnl.uni'r'ulumn'l,lnf.r:rtnm!umnhroalfinthﬁdocumnnt

i the secondcolumn, entert he heading, “Your Qualities’

L : ‘ﬂ i.l -)i -] IO / , r :

se the Format Palnter button to apply the formatting of the heading, ‘NAME’ and apply it on the

heading, Your Qualities”,

col the leftmargin of column 2 by dragging the ' _
. | | g BIRTHDAY RECORD
{|tll||l|f"]|‘-'"d'-'" arrow towards left before HAME  DOB Your Qualities

January- fou're rbitious,

Frbruary- fou're Quiet, Sy, and Humble

Lhreya  January 17 smart, and Organised

typing the text,
, I ' | " ||t Joand —— Yushal  February %
find the word ‘Polite” ant replace It with

Yikat Julg 17 July o' Friendly, Canng, and Loving

Fliga “epemberld ceprember- fou're Calr, tind, znd Sympathenc

‘Courteous’,
save the flle by pressing ctrl + S key

combination and exit Word 2016.

Harshad  March 260 1harch- fou're frtractive, Afectonate, znd Moody

June- fou're Polive, Saft cpoven, and Sensitve

Jpehreet  June 27

' SO TG, nsert Header _ o ’
npu-HWul:l Iy i "h"“““W"*”“‘“‘flCl.'!sslv R Y ‘f” ?‘1

wilte the leading BIRTHDAY RECORD, ¢
clect the heading, apply orange colour and align it to the

GROUP DISCUSSION §  For Concept CIarty . e
SR

) 'pncln[f v Line spacing.
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WORKSHEET — ___-
—] Chapters 1-4 |

A. Fillinthe blanks.
__fromtop, bottom, left, andright edge of 1. "
0

The defaultmarginsaresetat .~
only two states ...

are the two types of primary memary,

2. Acomputercan understand . s [

3. i s——AS and.— o
4 The o o—icon is used to delete objects in Paint 3D.
5. .. displaysalist of drives and folders.

+ RAM *1" s Off » Navigation pane

m +On + Delete

B. State True or False.

The Inkjet printer can give only colour printouts.

The Tab key is used to move the cursor certain spaces in a document.

2.

3 Potrait is the default paper orientation in Word 2016.

4. InPaint 3D, you can only add 3D text to your canvas.

5.  Anoperating system controls all the activities of a computer.

C. Find the odd one out.

i k. Keyboérd i Touch Pad . Scanner Printer

2 MU - ALU VDU cy

3. Flashdrive DVD ROM Blu-ray Dick
4, Windows 7 Windows 10 : - Windows 8 Sticker

5 Vinod Dham Bill Gates ~ Satya Nadella Sachin Tendulk

D. Write the full form of the given acronyms.

1. CRT S

2. €D e —————
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\_,.-""'__—-
{ Chapters 1-4 -

\

choose the best answer.
Which device gives the output on a paper?

a. Pnnter b. Pen drive
¢. Monitor

The maximum capacity of multimedia cards is up to
5.223GB b.31GB c.512GB

indowsisa i
Wi s UISET INtertace.

a. Graphical
b. Character ¢. Word

which among the following tools is not used in Paint 30

2. 3D Text b. Effects c. 2D Library

~_usedin MS Paint.

paint 3D Text toolis an upgrade ofthe
b. Brush Tool ¢. Eraser Tool

1. Text Tool

Answer in one word.

Which input device i< used to record voice into the computer system’

Which input device can be used only with CRT monitor?

Name the latest version of the Windows operating system-

o add text to the canv
place the textinaWordd

Nzme the tool used t 35 in Paint 3D.

cut method is usedtore

Which short ocument? -
Answer the following q
y computer memory?

uestions.

Name its parts.

what do you understand b

Whatis a storyboard?

write any two features of windows 10.

What are Page margins? What ar¢ the default settings of Left and Right ! BIns-




JAGAT TARAN GOLDEN JUBILEE
SCHOOL

SESSION : 2020 - 2021

CLASS : 4

SUBJECT : ENGLISH

BOOK : THE ENGLISH CHANNEL
(Published by Indiannica Learning Private
Limited )

Study Material : Assignment 4
a) Chapter - The Silver Arrow
b) Chapter - The Old Green Door

Dear Parents/ Students,

Kindly follow the instructions given
below :

1. Type the link :
https://play.google.com/store/apps
/details?id=com.indiannica

2. Download the ILP app from Google
Play Store and view the video of the
chapter - THE OLD GREEN DOOR.

3. Do the given exercises in your
Literature notebook :



A. Hard Words -

adventures, dusty, mysterious, corridor,
explore, shining, terrible, scream, scared,
horrible

B. Word - Meanings -

i) mysterious - something that we cannot
explain

ii) chilling - frightening

iii) swore - made a promise

C. Question/Answers -

i) Where was the Old Green Door and
what was the way to it?

ii) Why were the students frightened of
Mr Lee?

D. Make Sentences With -
speech, scared, terrible



4. Type the following links for Grammar
Exercises :

a) https://youtu.be/laQUXyfVM9Y
(Adjectives of Quality/ Quantity/
Number)

b) https://youtu.be/om8mFN4d6VE
(Possessive Adjective)

c) https://youtu.be/Z5ISJUxKOpk
(Degrees of Comparison)

d) https://youtu.be/7B-uah2hkv0
(Cardinal/ Ordinal Number)

e) https://youtu.be/CYXDr_vHiik
(Personal Pronouns)

f) https://youtu.be/QMRndaJaTVw
(Demonstrative Adjective/ Demonstrative
Pronoun)

5. View the animated videos of the given
topics.

6. Watch the videos very carefully.

7. Complete the given assignment in your
Coursebook and Practice Book.

8. Do the given work very neatly.
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AB. Underline the suitable adjectives to make the correct word pairs. One has
been done for you (T bsok)

1. The merry men were (early / quick) risers.
2. Robin Hood liked to give the poor (cheerful / pleasant) surprises.
3. Robin Hood left for the contest after having a (bulky / heavy) breakiost.
4. A (strong / heavy) wind blew through the woods.
5. The birds in Sherwood Forest sang a very (pretty / beautiful) song.
6. Robin Hood happily rode his horse under the (tall / long) trees.

7. He reached the (working / busy) town for the competition. @
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Mnderline the correct words in the brackets to show the meanings of the
highlighted words. Use the dictionary to check your answers. One has been done

- for gou.@ﬁn b oot

1. To speak mockingly is to be (polite/rude).
2 When someone is mumbling, his speech is (undeor/c\eor).

e\




ReC

Grommor A

A. Underline the adjectives in this conversation. )
That was an exciting morning! Now it's time for some fooa.
An adjective describesa

RosINn
Cook  Where would you like to eat?
Rosin  Let’s eat under that shady tree there. AoLN Or A pronoun. \t can =
It is large enough for all of us. show quality, quantity,
and number.

Cook I'll ask those young men to place the four
benches and the high iron table there.

Roein  The thought of eating green vegetables and your famous

hot soup of tender shoots is making my stomach rumble.

Here you are! | see my boys carrying six large trays \aden

Cook
with plenty of food and drinks.






VZ :leplace the underlined words with possessive adjectives. One has been done
or you.

1. Robin Hood’s dress was made of green cloth.
His dress was made of green cloth.

2 The contestants’ quivers were filled with arrows.

2 The arrow’s pointed end was sharp.

e ———
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4. “You are Robin Hood's prisoner now, said Robin Hood to the sheriff.

5. W lihe guards: greed made them leave the sheriff alone.

A

6. Robin said, ‘The sheriff will live in myu and my men’s home in the woods!

( e
/ /]

\}2. Choose the correct words to fill in the blanks.

s forest is called Sherwood Forest. (Those/That)
2. The merry men live in forest. (this/these)

3 Robin Hood works with men. (this/these)

4. He will help villagers. (those/that)

5 What isin bags? (these/this)

6. Are horned beasts yours? (those/that)




consonaht =) |
vowel + single consonant big ' a \b'\gges't A

_E. Complete the table. One has been done for you.

Positive Compardt‘we \ Super\cmvej
1. sweet sweeter \sweetest j
Zef@st faster \ A
5), tastier \tost'\est l
4. pretty \prett\est A




& four

—ye
b”) Six

r o ! The students llked to:- J
o ]
Q) invent things b) explore new p\oces

) imagine and day

3. The students first heard a ‘coming from behind the door. .
a) roaring sound b) strange light ©) pounding noise
4. — was the slowest to flee the O\d Green Door.
a) Tom b) Jack c) Tara

5. Mr Lee asked the students to
a) help him open the Old Green Door

b) wait for him at the store
c) help him in the store

L et R



write the correct cardinal or ordinal number to complete each semer\ce@n‘uw\«)

1. Our school building has | floors. (three / third)

2RO class Is on the | floor of this building. (one / first)

3. The art room is on the floor. (two / second)
4> The library is floors above our classroom. (two / second)
5. On which floor is the library? It is on the floor. (four / third)

P



! T You bump inte table,

) D You knock into it.

) 2. If Yyou heqgr
a) h

ut Of UOUT way.

Py =S

king.
a crack of thunder, you b) see the clouds cracking
€ar a loud sound.

5 Ifone Stamps on g sand castle, one b) crushes it with one’s hand.

Q) crushes jt with one’s foot.

e crush some ice, you b) break into finy pieces.
) press it and make it smooth.
S. If a window pPane shatters, it b) turns into powder.
a) breaks into many pieces. '
6. If you anp a twig, you b) join its two broken pieces.
Q) break it into two pieces.
/. If you squ A i ' '

You squeal, you | b) cry out loudly with joy or in pain.

a) squeeze Something with force.

8. To crumble q slice of bread. one has to | |
Q) break it into small bits. b) mix it in some milk and soften i



Grammar _

Personal pronouns

. es.
A. Underline the personal pronouns in these sentenc e
s are
1. Tom and Tara are talking to me. Pr°n9un \ace of nouns.
2. | am listening to them. used in P

3. Uncle Ryan is also listening-to him. | e
4. We all felt scared on hearing about the Old Green D

i ' or.
5. They said they will never know what lies behind that do

O



B. Rewrite the sentences by using personal pronouns in place of the highlighted
words. One has been done for you.
1. The elephant trumpeted loudly. The elephant was calling its friends.
The elephant trumpeted loudly. It was calling its friends.
s score goals.

A

2. Sarma and Rao are good footballers. Sarma and Rao alway
3. The cat ran quickly. The cat tried to run up S

the tree.
The children got together. The children

4,
were practising for a play.
5 Raviis visiting Jay and Tia. Ravi will be
d Tia tonight.

staying with Jay an
6. Surbhi and Bordo wanted to go to the
village fair. Surbhi sgid. ‘Father, please LSS

take Bordo and me to the fair’
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D
5 emonstrative Pronouns
€ad this Pair of sentences.

* Tom h
If ohi . ad many Qadventures. These are his favourite ones.
IS Pair of sentenc

demonstrative pron

es, these points to the noun adventures. These is a
oun.

Demonstrative

o o Pronouns point out the nouns to which they refer. This, that, these

OSe are demonstrative pronouns.
> iS .
4 This js .used for singular nouns close to the speaker and is followed by is.
These is ysed for plural nouns close to the speaker and is followed by are.
> That is used for singular nouns far from the speaker and is followed by is.
> Those is used for plural nouns far from the speaker and is followed by are.

C. Fill in the blanks with the demonstrative pronouns from the brackets. One
has been done for you.

i This is a scary story. (This / These)

2, are huge doors. (Those / That)

5, is a mysterious message. (That / These)
4.
B,

are my friends. (This / These)
is a funny movie. (This / Those)




Remember, a demonstrative adjective is followed by a noun, but a demonstratiy
pPronoun takes the place of g noun.

D. Look at the underlined words in each sentence. Write DAifitisa \
demonstrative adjective or DP if it is a demonstrative pronoun. One has beey

done for you.

1. Something strange happens behind that door. DA
2. Which one of those doors is locked?




3.
4.

B
6.
7

8.

S
10.

That green door?

Can you hear these sounds?

This sounds like wolves and hyenas!
| know. But there isn’t an animal behind these doors.
This is a mystery.
This sound is not as frightening as the one | heard

last time. . -
Can we run away through one of those corridors:

No, those lead to the laboratories.




~ 1

gstrong wcmcm )
‘heavy heavy problem
C) fcir decision fair result

d) tough decision tough traffic

e)  well aware well knowing

) easy money smooth money
g) near friend close friend

h) sworn enemy promised enemy

2. Look at the pictures. Each face shows a different emotion.
Pick the emotion that matches the face best and write it under
its picture.

elated anxious furious sad




was much noise in

d the old man sitt
d to wait a long time
de the doctor’s room.

sofa. There
which trouble
corner. Jina ha

ing in oN€
pefore

she could go insi
Quality Quantity Number
: /‘_/T’—— 2.
: .

gl s e R B

R -

S e -

N

to show possession or belonging

Possessive adjectives are used
e?. My, your, his, her, its, our, and their -

They answer the question whos
are possessive adjectives.
Demo ‘ jecti ‘
2 Onstratlve adjectives point out NouNs Or pronouns IN a sente A
y answer the question which one?. This, that, these, and those =
_ : : are

demonstrative adjectives.



]

1) Wi B e . IS . A
- d) Tommuy's coat is very soft, | B

s

~

e) Rita’s shoes were brown in colour

|

3. Use the correct demonstrative adjective from the brackets to fill
in the blanks.

a) trees are huge. (These / This)

b) star is the brightest. (That / Those)

c) What is in | trunks? (this / these)

d) pen belongs to Sheena. (This / These)

e) Are

children still playing? (that / those)

we uSe adjectives in the comparative degree when two persons, _
animals, or things are compared. We add _er to make the comparative

degree. We also use than while making the comparison.
we use adjectives in the superlative degree when more than two

persons, animals, or things are compared. We add -est ‘Fo make the
superlative degree. We also use the before the superlative degree.



’ '-f—s ggs:e than science. (easy)

L postcard | have ever got. (preng) :
{:.;,," - The than she had expected. (hem'@)
- d) Itwas the . milkshake | ever had. (good) |
e) The mangoes Ginny bought are than the oneg

grandpa bought. (sweet)



bcnk.

) Mansi was the last one to wake up th's pReHc: ':r‘ K

d) There were five hundred peoplé protesting on the streets.
g always comes to me f".

e) When I call my dog and cat, my do

2. Look at the picture and complete the sentences with SU‘tOb\e

cardinal or ordinal numbers.




b) That man near the flowers is the gardener.
takes care of the plants and

tends to

c) Rohan and | are going for a film.

am excited about going with

d) is the king. People hold
in high respect.




E s h
wueen IS
g

Jerlir d"‘:words‘in each sentence. write DA if .t
: a demonstrative pro"ﬁu“‘

a) That is muy father.

b) All these are my dresses. \ &
©) This door leads to the green roor!. ———
d) This is the breaking news tonight — 1

e) Those boys made a lot of noise last evening.




JAGAT TARAN GOLDEN JUBILEE SCHOOL
Session : 2020-2021
Class 4 EVS (Book -Hello Earth)
Assignment 4
Study Material
Follow the instructions given below-

Visit and download the study material from JTGIS school website (http://jtgjschool.in)
Download the PDF of class 4(HE.....4...pdf)

Open the chapter 7 THE ANIMALS WORLD chapter 8 ROOTS AND FLOWERS

Read the chapters thoroughly

Try to understand the new words

Learn all the key words given at the end of each chapter.

oo s W
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Ls -7
One word answer:-

1. Bees suck nectar from flowers with their long thin tube like mouth--
. Ant and termites live in --
3. A small animal or plant that lives on or inside another animal or plant and get it’s food
fram it --
4. The way in which an animal's colour or shape matches it’s surrounding and makes it
difficult to see --
5. Bees hornet and wasps live in groups called --

Ls -8
One word answer:-

It is the main root of a plant that grows downwards--

These are large roots that grow on all sides of a tall tree--

It is the reproductive partof aplant --

Plants which grow in marshy areas are called -- _____

Extract of flowers like rose and hibiscus are used to make drinks called --

L

KEXXX AKX KEXEKEKR R == e KEXXKKER KEXKX
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Assignment

Do the exercises in your old notebook/school diary/activity sheet/any other notebook available at
home.

EXERCISES FOR CHAPTER 7 and 8

e Match the words

e Choose the correct option

Fill in the blanks

True fFalse

* Answer the following questions

Do 1,3,4,5 of Ls-7 and Do 1,2,5 of Ls-8
ACTIVITY
1.0Draw and paste pictures of same animals that camouflage.(Is-7)

2.0Draw well Iabelled diagram showing different parts of a flower. (Is-8)

Video Link:

https://youtube.be/DOGAGRIPDic

http://youtube.be/ -ROXGqgBSx|

https://youtube.be/X6TLFZUCSg|

https://youtube.be/VFKVRwDtCho

Scanned with CamScanner



Lhapter

S Thetlctar m—
oW shows animal o i s i oA
then match them to their grOUpsS Ih groups. Observe the animals and !

Animals Group
a. Fish Herd
b.Cows Flock
c. Bees Shoal
d. Birds = Swarm

Some animals live together and move around in groups. There are

different reasons why animals live and move in groups.

e They feel safe and protected in large groups and can defend
themselves from their predators.

e In cold regions, birds like penguins live in

i warm.

e Some animals move around in groups

areas where they can all gather and e

sheep, buffaloes, deer, zebras, giraffe an

for food, water and shelter.
hare their work in a group. Whil

he others protect and look afte
als to take care of their youn

groups to keep each other

because they find food in specific
at. Grazing animals like COWS,
d wild horses move in herds

e some animals get
r the group. Living

g ones.

e Some animals s
food for the group, t
in groups also helps anim

Scarned with CamScanner
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: groups 9557 . , or three njuale li¢::»r'|s:,_._-!-§._é
nd watches out for 1M nsisting ol tv{-ve with their young ong
Lions live in groups called Prid =) "o gphan®® 1 of the grouP- When g
" lionesses and their cubs. The fe;; is the le :
- groups called herd. The oldest

’ senses danger, she lifts her tru
' trumpets loudly. Wolves, fOX€s: «
move in groups called packs. A gro Z "

of chimpanzees, gorillas and monkey -
called a troop. Bees, wasps and horné ;

live in groups in hives and nests. Ants d

termites live in colonies.

ANIMAL BEHAVIOUR

i h
Some animals are very friendly while some are shy. Anum'als such as CFltS, g
and cows are friendly animals. If we are kind to these animals they will alsp

friendly towards us. But some animals like rabbits, squirrels and pigs may not
as friendly as dogs and cats. They may take time to respond to us because ﬁ
are shy. Name some animals that you have seen people playing with.

Animals like tigers, wolves, lions and foxes live in the wild. We can not befrié‘ri'
them because they are not used to human beings. E

Some animals like turtles and tortoises have a thick
shell on their bodies. They curl up their bodies inside
the shell when they sense any danger. Hedgehogs ( ' '
curl up into a ball if someone goes near them gsalso 2 WA L

HOW ANIMALS H

ELP EACH OTHER

Birds like egrets qre usually found on the b
e

"hey feed on the in acks of ¢
ense danger, th :[e cts found on the bodies of 4, attle, deer ang elephants.
AN, thus warping o €%€ ANimals. When these bi

animql

at attqch them 3

selves F
nains of the prauy ¢ .. to tUI’t[eS and larma fich

Scarned with CamScanner
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~on the parasites fot.Jl;l‘d- on the b

‘a crocodile and cleans its teeth. The ¢
not harm this bird.

The cleaner shrimp feeds on the parasites

rocodile does

Wolves and ravens also share a special relationship.
Wolves make food available for ravens by leaving
the carcasses. Ravens on the other hand give the
location of prey to wolves through their calls.

found on large fish. The shrimp gets its food
while the large fish gets rid of its parasites. This ‘ﬁ

way they mutually benefit from eac

h other.

Just like egrets, oxpeckers too feed off lice and
ticks on a zebra's and a buffalo’s body. It also

helps the zebra by screaming when

is near.

HONEYBEES /

a predator

_.. S o :
; . g, g P VR s R L .
odies of the host meE

animal. The Egyptian plover sits inside the mouth of

An oxpecker sitting on top of a
buffalo’s head

‘Bees and butterflies come to flowers for nectar which is sweet and is also food

for them. Honeybee
long thin tube-like mouths called

proboscis.

As the bees suck nectar, pollen grains from
the flowers stick to their bodies. Once their

stomachs are full, they spit out the nectar into

the cells of their hives. A hive is made up of

hexagonal cells. T

produced by t
this nectar turns into honey.

he cells are sealed with wax

he bee's body. After a few days,
Cells are built by worker bees from the wax that

s live in hives. They suck the nectar from flowers with their

f"’
Did you know?

A hexagon is
a shape of six
o

sides.

\,

comes out of their bodies.
e cover their hands, face and body and set the

In order to collect honey peopl
beehive on fire. The fire and the
hive is removed and the honey |

smoke
s extracted.

drives away the bees from the hives. The

Scarned with CamScanner
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ar. W animals who do not

: m to ;
ars which help the eare @ e nd bat have big eqr

Animals \iki
areas have

" Animals have e

) others have small ears. Howeve et desert oX o their body heat ang dlES..Thll
! I ears at all. Animals like the eflepes elp the™ t° Ltc?er regions have smqy o mPP'l';(.i;
i ox Bgpl came
N ears of elephants and des‘;rt Arctic fox in « elePhant senses a thre skin and *
l ? cool. The polar bear and L E dy heat hen the 4 bats use their blg t
0] ; n Bar Sometim
!’; ' e (:10 "&?ﬁﬁ?ﬁﬁ cide of the head: Foxeisaalso use their ears to {o.d matches
i 1 z:::r;psg :‘ergrﬁ v:nemies and to catch their pres Brs while 1 animal |
. a -
,‘ things. The polar bear completely closes its € : ““3:{;“‘:
_r swimming to keep the water out. Cc:mt e
B : hey just have two ear- 4 R ©
L Birds do not have outer ears—they JU>t Ay easily : 1 it to a
o holes in their heads. This enables the birds t0 )}: o 8 they @
| since outer ears would slow them down. Thoug WA XY Anim
. have tiny ears they are very powerful. They can hear An ear of an ostid podie

notice the .-j_ keep

sounds which even humans cannot hear.

Fox Bear Elephant Dog

1

Snakes do not have ears. They hear through vibrations on the ground. You
wonder how a snake sways to the music of the
snake charmer. It doesn't. It simply follows the
movements of the snake charmer.

Not all sounds can be heard by animals, While
some hear only high pitched sounds, o
only hear low pitched sounds.

thers can

Some animals called mammals
! ! ; ave hul ] i
hair, while others have thick fyr on thejr LO; their bodies. Some have very Lt
Odies, i

Scarned with CamScanner
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!r& “Animals like polar bears that live in cold
' areas have a thick coat of fur on their
;338 bodies. The fur keeps th
'9 trapping their bodypheafn;\“'mrm b?{ Sbe
i l T - Animals like Shahtoosh is a very expensive fur
camels that live in warm areas have thick obtained from the hair that grows on
) _s skin and very little hair on their bodies the chin of a Tibetan antelope and
g . : is very warm and fine. The Tibetan
Sometimes an animal’s colour or shape antelope has become endangered
matches its surroundi : because of shahtoosh. We should say
el to Blerd v ngs. This hElFfs the ‘No' to shahtoosh to save the animal.
ammq 0 blend with the surroundings The Government of India has put a
and hide from its predator or prey. This is ban on shahtoash for this reason.
J

called camouflage. The stripes on q tiger's
coat help it to blend with its surroundings so that it cannot be spotted. This helps

it to attack its prey. The stripes on the coat of a zebra trick the predator when

they are in a herd.
Animals like hedgehogs and porcupines have stiff parts called spines on their
bodies. These protect them from their enemies. The feathers on a bird’s body

keep it warm and help it to fly.

‘:('mr :

Discuss
Do you think it is right to kill
animals for their skin? Why?

We should not be cruel to animals. We should be
e ' ds. Forests are the homes of 53
sensitive towards their needs Activity

animals. In order to save their homes, we should not in your scrapbaok,
cut down trees in the forest. draw or paste pictures
of some animals that

* If you had pet animals at home, how would you can camouflage.
w

look after them?

Scarned with CamScanner
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LET'S REMEMBER __

in grovP k after their safety.
bout | o Loo
; ; moVveé a

Some animals [IVF{ a;:’oups have lea e(l;’le i shy. F e

imals that live In les iended b se th
Animals ., friendly whi el e befr th
Some cmlmcll L o wolves
Animals like lions,
not used to human presence. :
Animals often help each other.

le.

d by peop®- e

. . later collected PY ve tiny ears that oo

Bees proc;l}uce honey V;:l::z;ihem to hear. Birds ha
Animals have ears W

hear. _
i ans cannot
powerful. They can hear sounds which hu: o ot hairta keepd
Animals that live in cold regions have @ thic

: blend with their
Some animals’ colour or shape help the IS i[r(:ﬂs is called camoufigy,
surroundings and hide from its predator of prey-

them to fly.
The feathers of the birds keep them warm and help

I  c.
Predator An animal that kills and eats other animals 1
Specific Connected with one particular thing 1
Hive A structure in which bees live
Befriend To become friends
Prey An animal or bird that is hunted, killed of eaten by another
Parasite A small animal or plant that lives On or inside another animal o'rfp'
and gets its food from it
i A carcass is a dead body of an animal
Vibration A conti i
i 'nuous shaking movement or feeling
Pitch A measure of how high or |
: OW a sound s |
l Fur The short fine hair of certain Qnim s
- 3 . a ;_;'-____ :
- Camouflaging The way in which qn animal’

olour or shupe matches its surrour!d

and makes jt difficylt to see

Spine Any of the sharp
: animals

Pointed .
Parts llke needles on SOme plants and
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EXERCISES / |

A. Match the rows.
1. D : _
COQ i 2. Egyptian plover 3. Honeybees 4. Polar bear 5. Birds
a. Crocodile  b. Friendly animal c. Feathers d. Hives e. Thick fur

B. Choose the correct option.

I. Cows are
vi (i) friendly animals. (ii) unfriendly (iii) wild animals. (iv) None of the
' animals. above
.; 2. Egrets are found on the backs of
L4 (i) cattle. (i) fish. (iii) crocodiles. (iv) tigers.
3. Honeybees live in '
(i) hives. (ii) sheds. (iii) stables. (iv) kennels.
4. Desert foxes have
(i) big ears. (ii) small ears. (iii) no ears. (iv) none of the above
5. Which of these animals does not have ears?
(i) Elephant (ii) Bat (iii) Snake (iv) all of the above
C. Fill in the blanks with the correct words.
. (safe/

I. Animals live in large groups because they feel ...

lazy) :
watches out for the safety of the group. (worker/leader)

is a fish that attaches itself to turtles. (Remora/Raven)

hear through vibrations on the ground. (Turtles/Snakes)
on their bodies to protect them from their

5. Porcupines have
enemies. (fur/spines)

D. Write true or false.
| Animals that live in large groups have leaders.

e rabbits, squirrels and pigs are as friendly
parasites found on the bodies of the host animal.

2. Animals lik as dogs and cats.
3. Remoras feed on
4. The ears of the bird h
5. Animals that live in warm

elp it to fly easily.
areas have thick fur.

: ‘.ﬁf"‘l ;ﬂ
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E. Answer the following questions: .
I. Why do some animals Live I" [g e el
i 2. With the help of three examg s,
| : 3. How do bees produce honey o their podies?
; 4. Why do polar bears have thick fur ;’ o a7
| 5. What is camouflaging? HOW does |

/ _ : Tnk and Answer. /4

How are the big ears of a desert fox useful for them?

, how animals help each .

i | Creative Corner
Individual activity: On a chart paper, draw.or paste pictures of animgls that |
| can pet and the ones that live in'the wildeesiiie i a

(?" OUP activity: In groups of four.choose!
.dfary on it. Each grp;j_'p.'sho_u,ld"colle_c.t m >rm
" 9roups or othewwise (ii) The behavior
of the animal (iv)'The kinds”of-'ét.:frs the'ani|

mutually beneficial relationship with any other &

T
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L?ok at the picture and label the
different parts of the plant.

. Theplant body consists of two basic parts—the root system and the shoot
(stem) system. The root grows below the soil and the shoot grows above

the soil. Both the root and the shoot help the plant to live and grow.

_ROOTSYSTEM_f4

The part of the plant that first grows from the
seed is the root. The root holds the plant firmly

to the ground. It absorbs water and minerals
from the soil which are important for the plant

to grow.
There are two kinds of roots—taproots and
fibrous roots. The taproot is the main root of a
plant that grows downwards. It is thick and has

branches which spread out. Trees like peepal
proots. Find out other trees . o _

and neem have ta
and plants that have @ taproot.
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ut ind :
e ) ppfead w very e(: have fibrous
a

o)
of the stem. They do not gl; s
fibrous roots. Find out other p

roots.

|
! Functions of roots 1
i the solt. : ;
' ‘ * Roots hold the plant firmly to to make their food
fil £ rals from

| _ * Plants need water to grow a ;-
I The roots absorb water and disso |

t grow
the soil without which a plant annc;o?e -
* Roots like carrot, radish and turnip s

. i vegetables.

| Special roots
| i

perform special functions.

Prop roots
Some trees like the banyan tree have roots

’ 1 growing downwards from the stem. These
roots are called prop roots. They sometimes
get attached to the soil, and provide additionqgl

Support to the plant.

Buttress roots
Buttress roots qre large roots thqt grow on ql|

that grow in areas where the quality of st is not
good and the roots do not go deep.

These roots support the plant and q
SO alloyy ;
absorb more nutrients. oW it to

Food-storage roots
Roots of some plants like carrot, ragjgp, b
' HMip q

ra food that can be eqtep, ; G
 {

ome roots that
Besides the basic functions performed by roots, thee e . a
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Water~storage roots

Roots of some plants |j
] ; s like asparq -
during the dry Summer montl;),s 9us and pumpkin store water for the plant

| buds along the
.u g the roots that grow near the surface of the ground. As these plants

Roots of mangroves
| So’me plants like mangroves grow in marshy areas which have clayey soil. The
{- soil holds a lot of water and very little air. These plants have roots that grow
above the water. The roots hold the plant in place as well as allow it to breathe.

Aerial roots
’ Aerial roots are roots that are not covered by
‘ soil. These roots fix themselves to the ground

and become thick like trunks.

FLOWERS /i S R
- e A mangrove swamp
A flower is the reproductive part of a plant. It is also the most beautiful part of

a plant. Even though most plants have flowers, there are some that do not have
flowers. Flowers are of different shapes, sizes and colours.

Parts of a flower

Though the flowers may look di
parts—petals, sepals, st
sometimes have a sweet sme
stage. The stamen is the male pa

the anther that contains pollen g
he sty

fferent, most of them have the same basic
amen and pistil. Petals are bright in colour and

IL. Sepals protect the flower when it is in the bud
it of the plant that contains the filament, and
ains. The pistil is the female part of the plant
le and the ovary. The ovary contains tiny

that consists of the stigmd, t
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T o # : /" i3
O et ki T P Ry T g :mrv e."“:_' -l he pouen tube : _%'? E
< e'ggs L:alltéd the ovules_ When t ﬁlament- ..
t inc reach the stigma: the Stame"[ anthe, | .
ollen grains
potlen g . n the petoo{}u[e =

reproductive process begins [ e
flower. Once the flower become

fruit, the ovules become the s a
The seed germinates and becomes

sep’"ﬂll

parts of a flower

new plant. h

~ We shc
Flowering seasons of plants he s i should
- all flowers bloom:at the same t'm., envirol

A flower develops from a bud. But not N
P t times of the year. Usually spring . W

Different flowers bloom during differen |

P ' L 1

season when most flowers bloom. Springtimeé In India usually lasts from i pl
e
s F :j'

to April. v o
S0k 1A é, m

Activity
Draw or stick pictued * T

Flowers in everyday life

Flowers have many uses in our everyday life. Flowers
are used for decorating homes during festivals, of flowers that groy {
decorating pandals at weddings, making garlands different seasonsinyy , -
and for making rangoli. Extracts from sweet-smellin SErRdphankite makeg

' g Lfl@wer album. 3§

flowers are used for making perfumes, soaps and -
lotions. They are also used to make incense sticks. Extracts of flowers like ro

and hibiscus are used to make drinks called sherbet. The sweet mixture putinl
betel leaf (paan) is made of dried rose petals and sugar. The extract ]F: ﬁ
flowers are used to give flavour to fopd Extracts of f| Ow. xtracts o S:_Ez .
plant, sunflower and safflower qre used to make COOkinger; lOf the mustar ‘

S

o R—
PO —— B s | — %

Floral motifs are common designs used in
pottery, textiles, embroidery, painting, jewelle
brass ware, inlay work, etc. Florql patterns qr;y '

commonly used on bed covers, curtains, clothes Did you know?

and on floor and wall tiles. Flowers have q sweet smél
and brightly coloured

Petals to attract insects thﬂt

A visit to the florist
A florist is a person who sells fl ;?rry Polten gralns from g
_ A Owers, A City of € stamens to the stigma.
town usually has a wholesale market that se|e re; h;lps the plants to
roduce, -
W T
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We should take good care of plants and |
should not harm them. They help in protecting our
environment.

e What ' ; : '
are the ways in which you can look after the E;\S:?;nswe a
use Tiowers

plants in your gard
your garden or park? to express ourselves?

* The plant body is divided into two main parts—the root system which is under
the ground and the shoot system that stays above the ground.
e There are two kinds of roots— taproots and fibrous roots.

The two main functions of the roots are to hold the plant firmly to the soil

and to absorb water and minerals from it.

In some plants, the roots also perform some special functions.

o A flower is the reproductive part of a plant.

Different flowers bloom during different times of the year.

e We use flowers in many ways.

Mineral
Dissolve
Propagate

Filament

Stigma

KEYWORDS

A substance that is naturally present in the earth and are important for

the growth of the plant

Something which is mixe
To produce a new plant from a parent plant

A long thin piece of a part of the flower that lo

d with a liquid and has become a part of it

oks like a thread and

connects to the anther | .
The part in the middle of a flower where pollen is received
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SR e i
T "“-*-.._’ :: part of a ﬂowz:;::zs seeds
) q:-"::""”"":"“'-'3"'T.he.l'ong tf lct plant that pro a decoratlon
DV—“_"'Y ;hc‘:e,:ic;rr: zr a Pattern use? sismething
;:-I::f A large size or quantity ©

. An

AR wer mandi 5
i A. Match the rows. 3. Banyan tree 4. Flo | .5; R
I & I. Shoots 2. Roots : Wholesale d. Part of a e..._'l_ i
a. Absorb Water b. Above the ¢ arket flower - 3
i ] and minerals soil I z:

y B. Choose the correct option. 5 .
' m? B
! ’ I. Which of these does not have a taproot Sys_t? l (iv) All of Thi
(i) Neem (i) Grass (in) Peepa U

2. Which of the following roots can be eaten as vegetables?
(i) Carrot (ii) Radish
3. Mangrove trees grow in
(i) marshy areas.

(iii) Turnip

(ii) dry areas.
4. Which of these is the male part of a flower?

(i) Petals (ii) Stamen (iii) Sepals
5. Flowers are used for

(i) making garlands,

(iii) making perfumes. (iv) All of these

C. Fill in the blanks with the correct words,

I T s system of a plant grow
system grows below the soil. (root/sho

ot), (root/shoot)
++eeeeenee hold the plant firmly to the soil. (

| 3. The banyan tree has
" buttress)

2,
Roots/Stems )

...................

................... and

(jasmine/safflower), (rose/syn ﬂOWer) -------- flow

Scarned with CamScanner

(i) semi-dry areas. (iv) Noneg
(iv) Pistil

(i) decorating homes,

A Wh
(iv) Al of g}

o

v
ti.

S above the soil, while q ...
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D. Write true or fals.e. >
I. Plants have two kinds of
% 2. The flower abs

i §

E. Answer the following Questions,
I. What are the differ,

cards by pasting them on

fithe following topics and
1owing the different types of
oot system'helps the plant; (ii) A cha
ith (i) A chart showing how
dinieveryday:life; (iv) A model showing different parts
a flower; (v) A'chart on how a flower becomps a fruit.
Interdisciplinary activity: Write a paragraph about your favourite flower and
why you like it and read it out in class.

Weblinks: For more information go to— '
http://www.scienceforkidsclub.com/ plant-structure.html (Accessed on 14 April 2

TEACHER'S TIP S

Tell students about the importance of plants. Ask them how plants help us. Tell them about the different roc
| S R R e I e TR =

T e R T L N R A R e
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JAGAT TARAN
GOLDEN JUBILEE SCHOOL

Session 2020-21

Class- IV

Subject: E.V.S.

Video Links

Chapter7and 8
Follow the Instructions given below:-

To access the video tap the following links:

For chapter: 7and 8

Visit link: 1- https://youtu.be/DO6AGRJPOic
2- https://youtu.be/ -ROXGqBSxI
3- https://youtu.be/X6TLFZUC9g|

4- https:/[youtu.be/VfKVRwDtCho
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Follow the Instructions given below:-
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ﬂ Class Work

Multlplr

e

I. 761X NV 2. N72 » W} 3 N7 » H73 .1*. N4 M) .i" Ifﬁ
e | - : e P |
x 594 \
TR i
| |
F
i ]
‘f " 5
_ I
| |
(,,_..*... - - — e - - e ST IS ST LSRR
& f-........_..............._.__.._...._..
.‘
g EXERCISEAC |
Multiply:
1. 219 x 154 2. 268 x 315 3. 356 x 260
4, 506 x 709 5. 3672 x 204 6. 1505 % 630
7. 1040 x 498 8. 3875 x 210 9. 2115 x 302
-7

WORD PROBLEMS
Example 10: A computer game CD costs T 474. A CD store sold 265 CDs in a mont

How much money did the store receive for the CDs?

wlution:  Cost of 1 computer game CD = T 474
Total number of CDs sold in a month = 265

Total money received by the store = Y474 x 265
= Y 125610.

So, the total money received by the store for the game |
\ 12561

CDs was € 1,25,610.
@ Scanned with CamScanner
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cavernment ply,
ol |k esch, iR
ceof hmeadh, Hep

ArERS

{c
I‘amnh!- At

3 . or 1 ¢ for the O Jistan
vample 11: “To provide shad les of a 1044 at 4 | 45 342 km long? \
% £ 101 trees an both sides tedd I the rod ' pasien
¢ . oy
i ‘i trees will have 1o e "“" il pnctie 1O i ) 1',
¥ lI I L3 : -
.\ululhm: Number of trees |"l-l"""| " y i ! v 1 s :
¥ l:- 'I ! "' l
| SESS T ss iy Lanted 10 142 km E Y ki |
¥ - £
So. the total number of tree 1 4' !
" 1'2 v I"i | $ 1 :'j‘_
i - . _
. -
4.’:'{!?1—-*__..'—#‘—"__-"*
‘ -
“¥¥ EXERCISE 4D
L“‘:. J -
' . . eor cald { 698°
L. What is the cost of 175 transistors if cach tranusan e
2. There are 504 tennis balls in a carton. How many tennts balls are
: there in 163 such cartons?
; 3. A man donates T 955 every month to an eld apr kome. How much

: . o) )
does he donate in 3 vears? What moral valuce s cihibited by the man
I(Value Rased Question]

4. A ream of paper contains 480 sheets. How many sheets of paper, in
all, are there in 175 such reams?

5. A machine manufactures 9585 screws in a Jav. How many screws will i

manufacture from the beginning of the vear tll the end of September?
(The year is 2016.)

6. Inatarm, there are 127 apple trees in a row, How many apple trees
are there, of there are 1 rows in all? .

o A housng soviety i organising 4 new vear eve bagh
: club house. Fach tlat owner s supposed 1o contette
party. Find out the total money collected, §f
the whole society.

in the society
U150 fise the
thete are 120, late in

s. Rﬂh“ bup 10 50“ tﬂ'}" wnﬂh t Il!} rm;h r. h _
much money did he spend to buy the toys? of his 10y shop. How

v od P
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C oy Diravar s}‘

The g‘“’“:"'"‘”“ has recently introduced the “Swachh Bharat |« Dividend l*
Abhiyan'. Ankil, Vineel, Rita and Vrinda arc participating in | . Pemsinder ':
this cleanliness drive in their own way. AR

They have a week long mid-term break

and they go to a different park each day
lo make it clean by collecting bits of

garbage and pulting them in bags. They
get diflerent sizes of bags each day.
Given below is a table showing the bits
of garbage collected cach day and the
number of bits that they can put in a
bag each day. You need to find out how
many bags are completely filled each
day and how many bits of garbage are

left over?
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You can ajsq find

3'—2::6

How many 25 have been taken ay
How many times Jyas

Think about separntiﬁg 8 apples into

(Use the multiplication table of 2 to ﬁud oul 1
the answer by subtraction. Subtrac! 2 at a lime unti] they, 2t

——————

¥
=

et

h'-' NHA “'cn)

QOO B
OO0

2 906

S has 2 been subtracied to obtain 0 as
x2=anras5+2=rﬁ)

.

4 equal grtii-iiws of 2

————

-

-f- )
f'f -
-
;_,;'}'I/"—\\‘-. .

'\ »
" g

@
@

——

e
-
T

H.,

:

S
9

A

G

©

Ny
L]

vay when you reach zero?

each,

u
w

W
%

®
®
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We show 4 x 2 = 8 on the number line as given below:

This multiplication can be undone on a number line by starting at 8 and going Lo the
left by moving 2 spaces at a time until 0 is reached.

In all the ways discussed above, we find that when 8 apples are divided inlo groups
of 2, there are 4 groups. Another way of saying that a group of 8 can be separated
into 4 groups of 2 each or that there are four 2s in 8 as shown below:

- — 4 3—
' 8+2=40r2)?0r-§-4

Fieht divided by two is equal to four.
| Eight divide by tv q

4 .. .
In8+2=4,or2)8 the symbols + or ) means the operation of dmsi?n' respectively.
The number 8 is called the dividend, the number 2 1s called the divisor and the

number 4 is called the quotient.

+2= lient 4
Gez=i—ow -
]-————- Divisor ——-—I

L —Dividend

REMAINDER IN DIVISION

If there are nine fish and we make groups of 2, one fish will be left.
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a

mber ol Himes in ", Whrn |

t
b

'This 't 1
i N Y » Lo l‘hi"'*
i l.lit.':“‘|l Contained in the dividem! an
{ ding Is valled the remudnder. coplain 7 an exXact py
On iy . |0 does nol Jow 40 whi ¢
! \hlln}: do w7, we T thal ot '““"‘“.I. Lelow W\ u._h C

Sil d T PR s s bl p® g “liill.l
WENeven sives are 42, theretore. Ny \We may SdY th

y

" 3
at when we {“\_i‘l“*
:

{
R 3 .r . * ' : » ’
&i CMWT namibey of Himes (s times) 18 =
! the quotient is 6 and the remainder 1S .
| : . J [he fingl
:,)]il:i.illmll of o r aviinder mus ,
'lht‘l‘ ! o .': 't -~ ! i iy i 1l1~l-1. ~ v \
; :-: or A6 4 7 | always e le \\
, l)i"illlll]‘l = i—-:I'— '. t}i'lll tilf' fl|'y'l"l-.,' | ‘{
— Q=6R=4
: . . ication to check (i
Observe the lollowing to learn how we can ust multiplicati eck iy,
f.
"f‘_ il
? f) -" - - 1= f'a -
| g IO -
- 56 6) 4l «
0 | i =3
2 Y
7XB8B+4+0=56 -”:

' —Dividend

= R — i

|
(G-
L

Divisor "‘“—‘J l ——“".'liumaindcr
I Quotient
Thus, in the third division problem, 3 x 36 + | = |p9.
l i Rule: To check a division result, multiply the quotient by the divisor n;;,:]-_;;d the 1

product. The resull should be cqual to the dividend
(Divisor x Qualient) + Remainder = Dividend

) | % _ _
' ' A A N I AR A AIB Nt o -

‘1o this
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We can join 3 smaller groups of 4 1o form a group ol 12,

m_ﬁ

e O

P e e L R e

| A o

-

il

S e

XTI KT
r_‘:-:} (."_h.) € u.j g%:)

D @YD c{f e
% %’g & O

If3x4= 12, then 12 + 4 = 3. ——
If 3 times 4 equals 12, then 12 divided by 4 equals 3. L.

0 and 1 in division
@ If 0 is divided by any number, =~ &= When any number is divided by 1,

the quotient is 0. the quotient is the number itself.
0 5

For example, 0 + 3 = 0 or 0 For example, 5+ 1 =5 or )5
:. cr If the divisor is 0, there is no @ If a number is divided by itself
,;l* poulble answer that is, division (except 0), the quotient is 1.
':‘-f ioh by zero is not defined.
.1 ‘.1 a l
e :r = For example, 0}7, o)ﬁz' or 0)_ For example, 8 + 8 = 1 or 8] §
| *__. are all meaningless. 5o '—g—
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wEEE

{ o % s T,

' A .}?r"‘ G e, T :

i <& gxencise 5A

| P el both the s

[ 4 L Answ scl of nbjccts. In Do ets, o By
f } ( thin g::; the questions given below cach " ,

ave been separated Into equal grovP

(1] R w2 a8 2 S

|
{ (&7 | B lfﬁ V- |V ko 2 g 8.
: - l i" | ‘f -
BB D 8B |[SHEEGS
| : J :gliﬁ' ! P W W T N
I \-all [ﬁ -7 ) B | {I:; Bt S Q
e e e e et -
How many groups of 2s are there How many groups of ¢ . lhﬂ
in a collection of 122 in a collection of 12? |
The divisjon sentence for the The division sentence fo, the
above js above is

| — I

- 3
Complete cach sentence below,

(@) 2x9=184 1840

——

e
-

b) 8x3=24,5024 +3=! ™

3.

¥
Vrite o division Séntence for each repeated subtraction,

(@) 12 S—
—_— ) =4 - il ] 1 _ 7 7
B | ey 7 — 7
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Divide and check lﬁc ;nswcr.
1. 2930 + 3 2, 6332 +6
Solution: Solution:
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*
pxample 6: Divide 5937 by 6R,

solution: | Ry | T A T T R A S e
ﬁﬂm-j-?- T Explanation: The }Hvlmu OGN oo 2t sambier, Wiy not
| . %44 | | contisbned in the et 2 digits 59 of e dividend. S0, We
q97 ! consider 793 Since we do not now Ve multiplication
- 76 table of 68, we tike only 6 1 68 and 59 in 593, Now 59
i 2l | b6 = 9 with remainder 5, 50 fet us try 9 an the quotient,

Multiplying, 68 by 9, we pet 612, a number which is preater
than the dividend 593 (You should do this trial memtally

without writing, il down).
WTherefore, we try 8, the next number bilow 9. We have
6B % B = 544 which is less than 593, so write 8 above
the last figure 3 in 593, Now complete as shown.,

e e e i PR

S50, Q = 87 and
R = 2{.

Example 7: Divide 28,969 by 72 and check the answer.
Solution:

02 Note: 1n the second step, since 72 does not divide 16,
72)2896Y we put a 0 in the quotient and bring down 9 also.
-'—28% Check: Here, divisor = 72, quotient = 402, remainder
- 144 and Dividend = 28,969
£ We have, Divisor x Quotient + Remaindc
) 7 % 402 + 25 = 28,944 + 25 = 28,969 = Dt
s
- ,!.-.i.-.._r....:l--. et R : e .. .;:
o EXERCISE5B |
Divide:
1. 294 + 3 2. 8001 +9
4, 6530 =+ 8 5. 3262 +6
7. 49072 + 6 8. 6203 + 12
10. 525 + 16 11. 7973 = 17
13. 8615+ 14 14. 2189 = 63 15. 6035 = 56

16, 768 + 64 17 79041 +53 18, 6470292

19. 60350 =+ 86 20.
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ON
! Yampy, 8- ol 10, 100 AND 1000
| (D‘vldc cach of the following mumbers By 70 (
Solug,,, (:; 18 (b) 622 (3 710y
(b) =
NP
Ilj]‘.}?rh .
U
b3
A
Thus, 48 = 10 gives 622 + 10 gives 7109 N
QUHHEI’II = 4 Qﬂﬂliﬁﬂt = 62, Qu“t;‘ Ifj '
% Remainder = g Remainder = 2 Remﬂf"‘ i
I?m the aboy “dh:
: u;;'----‘.-..__E_“_fﬂmplcs. we have the following rule:
i $ O e S e
.: 0 thﬂ dlgﬂ;”i["ng 2 numbcr b}, Iﬂ. We remove the dign at thc Ones plﬂCE lf-‘;".,i ".-HH._1
:rﬂmuindcr © 0 form the quotient, and the digit we remove from the Onheg p?u I,
: Y,
S"-‘Pﬂl‘ﬂte\
Thus, P——_—l
3‘:9 * 10 = Quotient = 49 and Remainder = 2
e /1. *+ 10 = Quotient = 311 and Remainder = 5
: S".-'Pﬂl‘ﬂ_te. |
Exﬂm ,.E 91. :
Ple 3. E_D;vide cach of the following numbers by 100.
a) 536 (b) 2789
: (c) 18019
SOIutlﬂff: (ﬂ) (b) 27 (C) e ——
180 |
100 2?3T Ilﬁﬂm|
-200 -100} |
789 801
=700_ -8001
-89 . 9
-
| -
~ Thus, 536 + 100 gives 2789 + 100 gives 18019 + 100¢

Quotient = 5,

Quotient = 27,
.. Remainder = 36

Quaotient = I¥
Remainder = 89

Remainder =1
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o W m— o ———

Separale

\é 1
Thus, 40 65+ 100 = Quotient = 40 and Remainder = 65
373}%%%— 100 = Quotient = 378 and Remainder = 93

Separate —1

Example 10: Divide the following numbers by 1000.

(a) 4673 (b) 15893 (c) 643895
Solution: (a) r (b) (c)
1000’4673 lOUOj 15393 1000’643395
-4000 -1000} -60004 |
T 4389

673

5893
-5000
893

-4000
3895
-3000

895

643895 + 1000 gives
Quotient = 643,
Remainder = 895

Thus, 4673 + 1000 gives 15893 + 1000 gives

Quotient = 4, Quotient = 15,
Remainder = 673 Remainder = 893

So, we have the following rule:
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IR gt v p e o e
[ & Classwork .. 3, 1567 4 1)
! e —— Quotien

i Di i : oy !
. 14 vide and weige the answer, - =40 / "-} ik
- L4z 3, 695 ;:nl N Remainde,
. P . - uo ' ' |
: if Quuhrnl a - / . indl.'f = i-"-" ' 4 6. 67894 4 "“I
Remainder = | E Rem3 Quotien '

L ]
.

- 4. 389 - 100 o 5, 50657 100 ( )
; ’ = i Remainde
Quﬂlicm -~ Qunﬂﬂﬂ — i Cr . ,

: / - > 2
’ : Remﬂjﬂder _ r" sl Rcmimdﬂ Gl 9- 2453:.2 s lf]{jrj
- 7. 7942 = 1000 ]. 9045211-1“"?_ ( *' _
Quotienty = { Quotient = = Remainder _
- J =
Remainder = 8 ftemainder =
e e et
Example 11: Divide 5873 by 80. :
Solutioy. ;
' l 73 E
! 80) 5873 !
-5604 | ;
273 :
~-240 | !
33 ;
8 So,Q=73,R =133 r
{ye "id 1
,'_'f Divide using both lﬂﬂg and short methods.

|

l

! 1. 40)367 2. 70)564 3. 20)121 4. 90);
!

| 5. 80J4080

f 0) 4080 6. 70)189] 7. 200)3142 8. ﬁfJ{f_
G | WORD PROBLEMS

L Example 13: A book contains 1024 pages. Ayushree said she would read 16
.;; day. How many days will it take her to read the book? ~
Solution:  Number of Pages in the book = 1024 |
Number of Pages o be read in | day = 16 ll
Number of days taken to read the book =~ 1024 -
Hence, Ayushree would take 64 days 1o r- W
ead the book. 1
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Pvarmple 14 "there are 5000 newspupers, 49 ne
viwtlous nrens, How miny ne
many are lellf

wapaper boys deliver these papers to
wapapers does ¢ach boy deliver and how

3t
!
;

Sﬂhlﬂﬂﬂ: "Total number nf'lh'wslulprru KON l{'));'ii:*;l{j"
Number of newspaper hops — HY ;45{

Number of newspapers delivered by cach boy AT |

SOD ¢ #y K2

So, cach hu)' delivers 50 newspapers and 16 newspapers are e, ‘ M-IEL.

Example 15: “The product of two numbers is 15808, 1f one number Iy 26,

find the
other number,

Solution: Product of two numbers == 15808

Given number = 26

Other number = Product + Given number
= 5808 + 26 = 6UH,

R W S————

. g W TH RS ¢ i R S W W T ——

.'!fij_l.ﬁ:{[l)fl L As 26 doces not po into 20, put
=156 ] the 0 in the quotient and bring
208 down 8. Now divide 208 by 26,

-208 . S ——
0 So, the other number is 608,

'";11\‘
s AT AT LA TR

- PSR I E S

1. Alka has 495 photographs to pul in an album. She can pul ¥ photographs on cach page. ow
mnnypngcs can she Aili?

2 Vwek arranged 1105 books in 13 bookeases so that each case had the same number
" of books. How many books did Vivek put in ench lumkcnfr? ’
A jndy paid T 900 for 15 cans ol cold drink. [low much did she pay for cn:h c[:ml;
LA prize money of ¥ 6,633 was distributed equally among 11 players of a foolba

2 » did every player get?
" team. How much money did every p | =
A satellite made 496 orbits around the carth in the month of January. How many arbits d

L] L ¥ L . ?
Uit make each day, If equal number of orbits were made cach day?

'Thi:'"’gardencr Ramu had 5,000 flower seeds, [1e began putting 18 seeds in cach row.

"o ’ l H\Tf?
- How many complete rows could he make? [Tow many sceds were lr:rf ce If cach bag
. What is the least number ol bags needed to hold 3,800 ld]ngnln;.fi“n‘mn;c;ui b
holdsﬁs kilograms? 1low many more e lllt"-‘l"f‘l . III l 1 36 students can ride on
N e Mg = sy |  t { more [han J0O . W isi
Vo1 e total enrolment of 8,044 students and no i)
ve tolal en school picnic?
”ﬂ;z:d' Wohanl:ls the Jeast number of buses needed (o bring all the students for & I

-

et L L

B et T e ’
e TR i S T
e A PR O
- - C 5 i -
S p W Mot

e ——
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APPLICATION OF THE FUNDAMENTAL OPERATIONS 1IN REAL LIV
SITUATIONS

M Verm ind 1875 Cheonlar heads, She Kept A1 adde and mude 6 neddaoens

Eoaarnple 1o
with equal number of beads from the remalnbng beads, Vlow

nuny beads does cach neckluce havet 24 3
Solution: Total number of heads 1D h? ":T' \
Beads wsed foe necklnces  IRS < A1 144 N ’?‘ ﬁlq
Since o necklaces ave made, theretore, number 24 \
of beads in ench necklace 144 1 6 = 24, LS

Example 17:  Rishi took 3 volls of film to o camy. LBach roll could capture 24 pictures,
If he took 44 pictures, how many complete rolls and pictures were left

10 be used?

Solution: Total number of pictures in 3 rolls = 3 % 24 = 72
Pictures used = 44, —
Remaining number of pictures = 72 - 44 = 28, 24) 28
So, number of rolls and pictures left = 28 + 24 w2 38
d
= 1 roll and 4 piclures. \ _——
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1. The bogk Storekeeper orders 25 books of Mathematics for T 90 each and 32 books

“rl‘:l'l
for ¥ 8p each. How much does he have to pay in all? |

2. John was paid ¥ 485 each day when he worked as a salesman. Later he workg, -

and was paid ¥ 35 an hour for 12 hours each day. How much more did he ¢y, ™ (
if he worked as a salesman instead of working as a cook? (Assume that he Worke| |
a week.)

¥
3. Ravi, Pankaj and Subodh are fond of collecting stamps. Ravi has till date collecie| | 170y
Pankaj’s collection is three times that of Ravis collection while Subodh has 875 less g
than what Pankaj has. How many more stamps does Subodh have than Ravi? |

¥
¥

4. Mr Saxena divided a sum of 7 98,280 equally among his 3 children—Vishal, Vikas and Vi

Out of his share, Vishal purchased books for 3,525, an iPod for T 9,870 and paid T 421
the canteen charges. What was the balance amount left with him?

>. Jai and his friends formed a team and took part in a game. He scored 435 points. They

- score of his team was 11 times as manv poi .
L y points as his score. How many points dic his fii
in the team score? ny points did his re

6. Rosa baked 224 chocolate pastries and pineapp] : "
who played outside her bakery, She P: Ckcdpfhi ll]f’-‘ISIl'ics for the poor and needy chit

& s § t equally | cos, There we
- chocolate pastries in each box while the rest were | qQually inta 16 boxes. There v |

.. ﬂlll'ﬂ'l l g TG ' Ay pined”
pastries were there in each box? What valye of Rosa is dc:'uPc:ctl; ‘;f:::.[;, :f l;m ::hm': : ,I:tj .
e alue HBased e
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>
&3 \ouTube

Division Story Problems | Maths For
Kids | Grade 4 | Periwinkle

Division Story Problems | Maths For...
www.youtube.com

1,nttps://youtu.be/cT
-dxQ2clz8

2,nttps://youtu.be/KQ
_Ox_dErcY

3,https://youtu.be/
-p8XA|k_FjW 8:02 pm

[
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JAGAT TARAN
GOLDEN JUBILEE SCHOOL

Session 2020-21
Class- IV

Subject: Maths

Video Links

Follow the Instructions given below:-

To access the video tap the following links:

Visit link: 1- https://youtu.be/cT-dxQ2clz8
2- https://youtu.be/KQ_Ox_dErcY

3- https:/[youtu.be/-p8XAlk_Fjw

¥ 46/32B, A.N. JHA MARG, GEORGE TOWN, PRAYAGRAJ % 0532-2468802 www.jtgjschool.in
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